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Cautions

1. Hitachi neither warrants nor grants licenses of any rights of Hitachi’s or any third party’s
patent, copyright, trademark, or other intellectual property rights for information contained in
this document.  Hitachi bears no responsibility for problems that may arise with third party’s
rights, including intellectual property rights, in connection with use of the information
contained in this document.

2. Products and product specifications may be subject to change without notice. Confirm that you
have received the latest product standards or specifications before final design, purchase or
use.

3. Hitachi makes every attempt to ensure that its products are of high quality and reliability.
However, contact Hitachi’s sales office before using the product in an application that
demands especially high quality and reliability or where its failure or malfunction may directly
threaten human life or cause risk of bodily injury, such as aerospace, aeronautics, nuclear
power, combustion control, transportation, traffic, safety equipment or medical equipment for
life support.

4. Design your application so that the product is used within the ranges guaranteed by Hitachi
particularly for maximum rating, operating supply voltage range, heat radiation characteristics,
installation conditions and other characteristics.  Hitachi bears no responsibility for failure or
damage when used beyond the guaranteed ranges.  Even within the guaranteed ranges,
consider normally foreseeable failure rates or failure modes in semiconductor devices and
employ systemic measures such as fail-safes, so that the equipment incorporating Hitachi
product does not cause bodily injury, fire or other consequential damage due to operation of
the Hitachi product.

5. This product is not designed to be radiation resistant.
6. No one is permitted to reproduce or duplicate, in any form, the whole or part of this document

without written approval from Hitachi.
7. Contact Hitachi’s sales office for any questions regarding this document or Hitachi

semiconductor products.
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Preface

These application notes describe the USB Function Module that incorporates the SH7727. They
are provided to be used as a reference when the user creates USB Function Module firmware.

These application notes and the described software are application examples of the USB Function
Module, and their contents and operation are not guaranteed.

In addition to these application notes, the manuals listed below are also available for reference
when developing applications.

[Related manuals]

•  Universal Serial Bus Specification Revision 1.1

•  SH7727 Hardware Manual

•  SH7727 Solution Engine (MS7727SE01) Instruction Manual

•  SH7727 E10A Emulator User’s Manual

[Caution] The sample programs described in these application notes do not include firmware
related to interrupt transfer, which is a USB transport type. When using this transfer
type (see section 23 in the SH7727 Hardware Manual), the user needs to create the
program for it.

Also, the hardware specifications of the SH7727 and SH7727 Solution Engine, which
will be necessary when developing the system described above, are described in these
application notes, but more detailed information is available in the SH7727 Hardware
Manual and the SH7727 Solution Engine Instruction Manual.
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Section 1   Overview

1.1 Overview

These application notes describe how to use the USB Function Module that is built into the
SH7727, and examples of firmware programs.

The features of the USB Function Module contained in the SH7727 are listed below.

•  An internal UDC (USB Device Controller) conforming to USB 1.1

•  Automatic processing of USB protocols

•  Automatic processing of USB standard commands for endpoint 0 (some commands need to be
processed through the firmware)

•  Full-speed (12 Mbps) transfer supported

•  Various interrupt signals needed for USB transmission and reception are generated

•  Internal system clock based on EXCPG or external input (48 MHz) can be selected

•  Low power consumption mode provided

•  An internal bus transceiver

Endpoint Configurations

Endpoint
Name

Name
Transfer
Type

Max. Packet
Size

FIFO Buffer
Capacity

DMA
Transfer

Endpoint 0 EP0s Setup 8 bytes 8 bytes 

EP0i Control In 8 bytes 8 bytes 

EP0o Control Out 8 bytes 8 bytes 

Endpoint 1 EP1 Bulk-out 64 bytes 64 x 2 (128 bytes) 

Endpoint 2 EP2 Bulk-in 64 bytes 64 x 2 (128 bytes) Possible

Endpoint 3 EP3 Interrupt 8 bytes 8 bytes Possible

Figure 1.1 shows an example of a system configuration.
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Figure 1.1   System Configuration Example

This system is configured of the SH7727 Solution Engine manufactured by Hitachi ULSI Systems
Co., Ltd. (hereafter referred to as the SH7727SE) on which the SH7727 is mounted, a serially-
connected PC, and a USB host PC (Windows 2000) containing the USB serial conversion driver*1

(manufactured by Hitachi ULSI Systems Co., Ltd.).

In this system, the SH7727SE can receive the USB packet data transmitted from the USB host PC
and transmit it to the serially-connected PC after converting it into serial data. Also, its reverse is
possible, that is, the SH7727SE can receive serial data from the serially-connected PC and
transmit it to the USB host PC after converting it into USB packet data.

This system offers the following features.

1. The sample program can be used to evaluate the USB module of the SH7727 quickly.

2. The sample program supports USB control transfer and bulk transport.

3. An E10A (PC card-type emulator) can be used, enabling efficient debugging.

4. Additional programs can be created to support interrupt transfer and isochronous transfer.*2

Notes: 1. For inquiries on this system (sample program and USB serial conversion driver),
contact your Hitachi sales agency.
The USB serial conversion driver operates only with a vendor ID of 045B
manufactured by Hitachi, Ltd. To use the USB serial conversion driver in your product,
a contract concerning the USB serial conversion driver must be separately
manufactured with Hitachi ULSI Systems Co., Ltd.

2. Interrupt transfer programs are not provided, and will need to be created by the user.

1.2 Purpose of this System

The price reduction of PCs has been accelerated in recent days, and at the same time, the legacy-
free PCs (equipped only with new standard ports compliant to Plug & Play such as USB

USB F nction Mod le

USB cable

Serial cable
USB host

SH7727SE

•Windows2000

•USB serial conversion driver

• (manufactured by Hitachi ULSI Systems Co., Ltd.)

PC PC
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(Universal Serial Bus), but not with old standard ports such as a serial port) have started to arrive
on the market in large numbers. With this market trend, it may become impossible for the existing
serial devices to be connected with PCs and many existing serial devices to be used.  In order to
solve this problem, a device which converts the existing serial line into the USB is required.

These application notes aim at providing an example of realizing the USB serial conversion
function to solve this problem.

In this system, the USB does not exist when seen from the existing serial application.  This is
realized by providing the serial API when the existing serial devices are replaced by the new USB
devices.  This allows the application program to be used without changes.

Figure 1.2 shows the hardware and software configurations when the PC and serial devices are
connected via the existing serial line.  Figure 1.3 shows the hardware and software configurations
when the PC and serial devices are connected via the USB serial conversion device.

As shown in figure 1.2 (a), the serial devices are connected to the PC via the serial cable in the
existing system.  However, as shown in figure 1.3 (a), the USB serial conversion device is
required between the PC and serial devices when the existing serial devices are connected to the
PC via the USB.  The USB serial conversion device has a function to convert USB signals and
serial signals mutually.  The PC and USB serial conversion device are connected by the USB
cable, and the USB serial conversion device and serial devices are connected via the serial cable.
This makes it possible for the PC and serial applications to communicate with each other.

Figure 1.2 (b) and 1.3 (b) show the software configuration expressed in hierarchical structure. The
connection indicated by a dotted line shows the image of logical connection.



Rev. 1.0, 04/02, page 4 of 64

Figure 1.2   Example of Connecting PC and Serial Devices via Existing Serial Line

Figure 1.3   Example of Connecting PC and Serial Devices via USB

In figure 1.2 (b), transmit data from the serial application in the PC is sent to the serial port driver,
which then sends the data to the serial hardware of the PC.  The serial hardware sends this data to
the serial hardware of the other end via a serial line.  The serial port firmware of the serial device

Serial port driver

Hardware

Serial

application

Serial port farmware

Hardware

(b) Software configuration

Serial devices
(PC, measuring device, TA, etc.)

Serial cable

(a) Hardware configurationPC

SerialSerial

Serial

application

Virtual serial port deriver

USB driver

Serial port farmware

USB farmware

Serial port

farmware

(b) Software configuration

USB cable

USB serial conversion device (SH7727SE)

USB B connector Serial connector

Serial devices

(PC, mesuring device, TA, etc)

Serial cable

PC
(a) Hardware configuration

USB serial conversion chip (SH7727)

Existing serial

application

Hardware Hardware

USB USB Serial Serial

Hardware

Existing serial

application

Hardware
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extracts the data from the hardware that received the data and sends it to the serial application.
Herewith the data can be exchanged between serial applications.

As in figure 1.3 (b), the transmit data from the serial application in the PC is sent to the virtual
serial port driver.  This virtual serial port driver has the same application interface as the existing
serial port driver. This allows the USB to not be recognized from the existing serial application,
thus enabling data communication without having to change the existing serial application.  The
virtual serial port driver passes the data from the application to the lower USB driver.  The USB
driver then passes the data to the USB hardware in the PC.  The USB hardware transmits the data
through the USB bus to the USB hardware in the USB serial conversion device.  The USB serial
conversion device converts the received USB data into serial data and transmits it to the serial
devices.  The communication between the USB serial conversion device and serial devices has the
same configuration as in figure 1.2.  This makes it possible for the existing serial applications to
exchange data with each other.

These application notes give an example for realizing the firmware operating on the SH7727SE,
which is equivalent to the firmware in the USB serial conversion device in figure 1.3 (b).
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Section 2   Development Environment

This section describes the development environment used to develop this system. The devices
(tools) listed below were used when developing the system.

•  SH7727 Solution Engine (type number: SH7727SE01-C/S) manufactured by Hitachi ULSI
Systems Co., Ltd.

•  SH7727 E10A Emulator manufactured by Hitachi, Ltd.

•  PC (Windows 95/98) equipped with a PCMCIA slot

•  PC (Windows 2000) to serve as the USB host

•  USB serial conversion driver manufactured by Hitachi ULSI Systems Co., Ltd.

•  Serially-connected PC

•  USB cable

•  Serial cable (cross cable)

•  Hitachi Debugging Interface (hereafter called HDI) manufactured by Hitachi, Ltd.

•  Hitachi Embedded Workshop (hereafter called HEW) manufactured by Hitachi, Ltd.

2.1 Hardware Environment

Figure 2.1 shows device connections.

Figure 2.1   Device Connections

AC adapter provided

with Solution Engine

E10A PC (Windows 95/98)

USB host PC (Windows 2000)

USB cable

Communication

between two PCs

Convert USB packet data and

serial data mutually.

SH7727SE

Cable for E10A

Install HDI and HEW for

compiling and program

debugging.

Serially-connected PC

Serial cable

USB serial

conversion driver



Rev. 1.0, 04/02, page 8 of 64

1. SH7727SE

The DIP switch settings on the SH7727SE board shown in table 2.1 must be changed from
those at shipment. Before turning on the power, ensure that the DIP switches are set as shown
in table 2.1. There is no need to change any other DIP switches.

Table 2.1   DIP Switch Settings

At Time of Shipment After Change DIP Switch Function

SW1-6  OFF SW1-6  ON Selects endian

SW1-8  OFF SW1-8  ON Selects E10A emulator

Note: This sample program uses the internal clock from the baud rate generator in the SCIF2
instead of the external clock from the SH7727SE as the SCIF2 transfer clock source.
Therefore, the transfer speed need not be set with SW4-1 and SW4-2.

2. USB host PC

A PC with Windows 2000 installed, and with a USB port, is used as the USB host. A USB
serial conversion driver (manufactured by Hitachi ULSI Systems Co., Ltd.) should be installed
in this PC.

3. Serially-connected PC

A PC with a serial port is used for transferring serial data.

4. E10A PC

The E10A should be inserted into a PC card slot and connected to the SH7727SE via an
interface cable. After connection, start the HDI and perform emulation.

2.2 Software Environment

A sample program, the compiler and linker used, and the USB serial conversion driver are
explained.

2.2.1 Sample Program

Files required for the sample program are all stored in the SH7727 folder. When this entire folder
with its contents is moved to a PC on which HEW and HDI have been installed, the sample
program can be used immediately. Files included in the folder are shown in figure 2.2.
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SH7727

CatProType.h     CatTypedef.h                                SetMacro.h           SetSystemSwitch.h
SetUsbInfo.h            SH7727.h     SysMemMap.h  

DoBulk.c                DoControl.c                                             DoRequest.c          DoSerial.c
StartUp.c    UsbMain.c          DoReqestVenderCommand.c                       sct.src
   

debugger.ABS        debugger.MAP           debugger.MOT     log.txt     dwfinf(
BuildOfHew.bat      InkSet1.sub

Debugger.hds         Debugger.HDT            7727E10A.hdc

Figure 2.2   Files Included in SH7727 Folder

2.2.2 Compiling and Linking

The sample program is compiled and linked using the following software.

Hitachi Embedded Workshop Version 1.0 (release 9) (hereafter called HEW)

When HEW is installed in C:\Hew*, the procedure for compiling and linking the program is as
follows.

First, a folder named Tmp should be created below the C:\Hew folder for use in compiling (figure
2.3).

C:\

\Hew

\Tmp

Figure 2.3   Creating a Working Folder

Next, the folder in which the sample program is stored (SH7727) should be copied to any drive. In
addition to the sample program, this folder contains a batch file named BuildOfHew.bat. This
batch file sets the path, specifies compile options, specifies a log file indicating the compile and
linking results, and performs other operations. When BuildOfHew.bat is executed, compiling and
linking are performed. As a result, a Motorola S-type format file named debugger.MOT, which is
an executable file, is created within the folder. At the same time, a map file named debugger.MAP
and a log file named log.txt are created. The map file indicates the program size and variable
addresses. The compile results (whether there are any errors, etc.) are recorded in the log file.

Note: * If HEW is installed to a folder other than C:\Hew, the compiler path setting and settings
for environment variables used by the compiler in BuildOfHew.bat, as well as the library
settings in InkSet1.sub, must be changed. Here the compiler path setting should be
changed to the path of shc.exe, and the setting for the environment variable shc_lib used
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by the compiler should be set to the folder of shc.exe, the shc_inc setting should be
changed to the folder of machine.h, and the setting of shc_tmp should specify the
working folder for the compiler. The library setting should specify the path of shcpic.lib.

BuildOfHew.bat debugger.ABS

debugger.MOT

debugger.MAP

log.txt

SH7727

Figure 2.4   Compile Results

2.2.3 USB Serial Conversion Driver

Files required for the USB serial conversion driver are all stored in the UST-03 folder.

UST-03

UST-03.inf UST-03.sys

Figure 2.5   Files Included in UST-03 Folder
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2.3 Loading and Executing the Program

Figure 2.6 shows the memory map for the sample program.

PNonCash area

P, C, D, and DNonCache areas

Control transfer data area

Bulk-out transfer data area

Bulk-in transfer data area

B and R areas

Stack area

PInterrupt area

PResetException area

SH7727SE SDRAM (area 3)

PGeneralException area

PTLBMissException area

AC00  0000

AC00  3000
CC00  2704

AD00  3047
AC00  4000

AC00  40FF
AC00  41FF

ADFF EBFF

A500 71F4
A501 7000

A501 7000

A501  8FFC

AC00  00C3
AC00  0100

AC00  048B

AC00  0400
AC00  013F

AC00  0653

AC00  0600

AC00  10B7

AC00  1000

CC00  1400

64 bytes

94 bytes

76 bytes

876 bytes

3653 bytes

72 bytes

256 bytes

256 bytes

522 bytes

Approx. 8 kbytes

136 bytes

Note: * Since allocated to the P3 cache write-through space, addresses A31 to A29 become 110.
             The memory map differs according to the compiler version, compiling conditions, firmware
             upgrade, etc.

Figure 2.6   Memory Map

As shown in figure 2.6, this sample program allocates all areas P, C, D, R, and B to SDRAM. In
order to use the E10A for break and other functions, the program must be placed in RAM in this
way. These memory allocations are specified by the InkSet1.sub file in the SH7727 folder. When
incorporating the program in ROM by writing it to flash memory or some other media, this file
must be modified.

2.3.1 Loading the Program

In order to load the sample program into the SDRAM of the SH7727SE, the following procedure
is used.

•  Insert the E10A in which the HDI has been installed into the E10A PC, connect the E10A to
the SH7727SE via a user cable, and connect the serially-connected PC to the SH7727 via a
serial cable.
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•  Turn on the power to the E10A PC, serially-connected PC, and USB host PC for start up.

•  Initiate the HDI.

•  Turn on the power to the SH7727SE.

•  A dialog (figure 2.7) is displayed on the PC screen; turn the SH7727SE reset switch (SW1) on,
and after resetting the CPU, click the OK button or press the Enter key.

•  Select CommandLine in the View menu to open a window (figure 2.8), click the BatchFile
button on the upper left, and specify the 7727E10A.hdc file in the SH7727 folder. As a result,
the BSC is set, and accessing of the SDRAM is possible.

•  Select LoadProgram... from the File menu; in the Load Program dialog box, specify
debugger.ABS in the SH7727 folder.

Through the above procedure, the sample program can be loaded into the SDRAM of the
SH7727SE.

 

Figure 2.7   Reset Request Dialog

Figure 2.8   Command Line Input

2.3.2 Executing the Program

In order to execute the program which was loaded in section 2.3.1, Loading the Program, the
program counter (PC) must be set appropriately.

Batch file
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Select Register Window from the View menu to open the Registers window. On double-clicking
the numerical area of the register (PC) in the window, a dialog box appears, and the register value
can be changed. Use this dialog box to set the PC to H'AC00 0000.

After making the above settings, select Go from the Run menu to execute the program.

2.4 Method of Communication between PCs

2.4.1 Setting Up the USB Host PC

•  Following the procedures in sections 2.3.1 and 2.3.2, execute the sample program. When the
sample program is activated properly, the 8-bit LED on the SH7727SE displays 0xAA.

•  Insert a series B connector of the USB cable to the SH7727SE, and connect a series A
connector on the opposite side to the USB host PC.

•  The dialog box is displayed on the screen as below, and click “Next”.
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•  Select “Search for a suitable driver for my devide (recommended)”, and then click “Next”.

•  Select “Floppy disk drives”, and then click “Next”.
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•  Make sure “UST-03.inf” is to be installed, and then click “Next”.

•  Click “Finish”.

The installment of the driver has thus been completed and the SH7727SE is recognized as the
serial COM port by the USB host PC.

Next, a hyper terminal, a communication software which is a standard attachment of WindowsOS,
is initiated.

•  Press the Windows key and select “Start → Program → Accessory (or under Communicaton)”
to activate the hyper terminal.
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•  Input the file name (It can be random. USB-Serial has been input in the following screen.) and
click “OK”.

•  Select “COM3” for connection and click “OK”.
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•  The serial port is set within the range shown in table 2.2.  The figure below is an example with
the default values of this program entered.  After the setting, click “OK”.

The hyper terminal has thus been initiated.  If a value other than those shown in table 2.2 is
entered, the 8-bit LED of the SH7727SE displays 0x30, and the default values of this program
shown in table 2.2 are entered.  If a value within the range is entered, the 8-bit LED keeps
displaying 0xAA.

Table 2.2   Range of Possible Serial Port Settings

Item Default Setting of This Program Possible Settings

Bit/s [bps] 115200 9600, 19200, 38400, 57600, 115200

Data bits 8 8 or 7

Parity None None, odd number, even number

Stop bit 1 1 or 2

Flow control Xon/Xoff Only Xon/Xoff
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•  After the hyper terminal has been initiated, and before the communication begins, select “File
Menu → Property → Setting” and click “ASCII Setup…”.

•  Check the box for “Send line ends with line feeds” in ASCII Sending and then click “OK”.
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2.4.2 Setting Up the Serially-Connected PC

The hyper terminal is initiated similarly as with the USB host PC. Make sure to enter the same
values as the USB host PC to set the serial communication (bit/s, data bits, parity, stop bit, and
flow control).

2.4.3 Communication between PCs

Once the hyper terminals for both the USB host PC and serially-connected PC are initiated, the
characters input from the keyboard, text files, and binary files can be exchanged between the two
PCs.

The characters input from the keyboard of the USB host PC side are transferred to the serially-
connected PC.  Also, the characters input from the keyboard of the serially-connected PC side are
transferred to the USB host PC.

The text files can be transmitted to the other by selecting “Transfer → Transfer of text file”.

After selecting “Transfer → Reception of file → ZMODEM” in the receiving PC to make the
receiving PC wait for file reception, the text files and binary files can be transmitted to the
receiving PC by selecting “Transfer → Transmission of file → ZMODEM” in the transmitting PC.

Note: These application notes use a hyper terminal as a serial application to run on the PC.
When using other serial applications, whether operation is correct must be confirmed
separately.
This sample program performs flow control (Xon/Xoff). Therefore, a protocol supporting
flow control (Xon/Xoff), e.g. ZMODEM, must be selected for file transmission.
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Section 3   Overview of Sample Program

In this section, features of the sample program and its structure are explained.  This sample
program runs on the SH7727SE, and initiates USB transfers by means of interrupts from the USB
function module or branches from the main loop.  In addition, it initiates serial transfer by means
of interrupts from the SCIF2 or branches from the main loop.  Of the interrupts which are used in
this sample program from the on-chip modules in the SH7727, there is one interrupt related to the
USB function module: USBFI0, and three interrupts related to the SCIF2 module: ERI2 (reception
error), BRI2 (break reception), and RXI2 (receive data full).

Features of this sample program are as follows.

•  Control transfer can be performed.

•  Bulk-out transfer can be used to receive data from the host controller.

•  Bulk-in transfer can be used to send data to the host controller.

•  Serial data can be received from the serially-connected PC.

•  Serial data can be sent to the serially-connected PC.

•  Serial transfer can be used to send data received by bulk-out transfer.

•  Bulk-in transfer can be used to send data received serially.

3.1 State Transition Diagram

Figure 3.1 shows a state transition diagram for this sample program. In this sample program, as
shown in figure 3.1, there are transitions between four states.

•  Reset State

Upon power-on reset and manual reset, this state is entered.  In this reset state, the SH7727
mainly performs initial settings.

•  Stationary State

When initial settings are completed, a stationary state is entered in the main loop.  In this
stationary state, the data from the USB host PC and the serially-connected PC are monitored
all the time, and if a data is detected, it is output to each of the other end PC.  In other words,
input data to the SH7727 is monitored constantly, and if a data is detected, it is output to each
of the other end PC.

•  USB Communication State

In the stationary state, when an interrupt from the USB module occurs, this state is entered.  In
the USB communication state, data transfer is performed by a transfer method according the
type of interrupt.  The interrupt sources used in this sample program are indicated by the
interrupt flag register 0 (USBIFR0) and interrupt flag register 1 (USBIFR1), and there are
three interrupt sources in all.  When an interrupt source occurs, the corresponding bits in
USBIFR0 or USBIFR1 are set to 1.
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•  Serial Communication State

In the stationary state, when an interrupt from the SCIF2 module occurs, this state is entered.
The interrupt sources used in this sample program are indicated by the serial status register
(SCSSR2), and there are three interrupt sources in all.

StartUp.c
DoSerial.c
DoBulk.c

StartUp.c

DoSerial.c

USBMain.c
DoControl.c
DoBulk.c

Reset state

Stationary state

USB
communication state

Serial 
communication state

Serial output
state

Serial output state

Serial output state

SCIF2 interrupt priority: 15

Serial communication
completed

Interrupt generated (RXI2, ERI2, BRI2)

USB interrupt priority: 14

Bulk-in transfer
state

Bulk-in transfer
state

Interrupt generated
(USBFI0)

USB communication
completed

Initial setting 
completed

Figure 3.1   State Transition Diagram
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The interrupt priority of the USB is set to 14 and that of the SCIF2 to 15. This setting does not
accept the USB interrupt during the SCIF2 interrupt processing and prevents the serial receive
processing from being delayed by the USB interrupt.

3.2 Overview of Communication between PCs

Figure 3.2 shows the overview of the communication between PCs.  In this sample program, there
are roughly two kinds of communication modes; USB communication and serial communication.
Considering the data transmission and reception, the USB communication can be categorized by
bulk-in and bulk-out transfer, and the serial communication can be categorized by serial input and
serial output.  Therefore there are a total of four communication modes in this sample program.

The data flow in this sample program can be categorized by two directions; from bulk-out transfer
to serial output, and from serial input to bulk-in transfer, each of which is given 256-byte buffer.
The input to the buffer of each direction handles interrupt operation and the output from the buffer
controls the output on branching from the main loop.  In the main loop, the RAM area for bulk-
in/bulk-out transfers, which is a buffer for both directions, is monitored consistantly and, if any
data exist, it is output from the buffer.

SH7727SEUSB host PC

Bulk-out transfer
RAM area for bulk-out
transfer 256 bytes

RAM area for bulk-in
transfer 256 bytes

Bulk-in transfer

Serial output

Serial input

Serially-connected PC

Serial

Serial

USB

USB

Figure 3.2   Communication between PCs
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3.3 File Structure

This sample program consists of seven source files and seven header files. The overall file
structure is shown in table 3.1. Each function is arranged in one file by transfer method or function
type.

Table 3.1   File Structure

File Name Principle Role

StartUp.c
Vector table settings, microcomputer initial setttings, and clearing
ring buffer

DoSerial.c
Executing serial transmission/reception., and controlling SCIF2
module

UsbMain.c
Determination of interrupt sources, and sending and receiving
packets

DoRequest.c Processing setup command issued by the host

DoControl.c Executing control transfer

DoBulk.c Executing bulk transfer

DoRequestVenderCommand.c Processing vendor command

SysMemMap.h Defining SH7727SE memory map addresses

SetUsbInfo.h Defining USB structure

SetMacro.h Defining macros

SetSystemSwitch.h System operation settings

SH7727.h Defining SH7727 registers

CatTypedef.h Defining structures

CatProType.h Prototype declarations
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3.4 Purposes of Functions

Table 3.2 shows functions contained in each file and their purposes.

Table 3.2-1   UsbMain.c

File in Which
Stored

Function Name Purpose

BranchOfInt Determination of interrupt sources, and call function
according to interrupt

GetPacket Write data transferred from the host controller to RAM

PutPacket Write data for transfer to the host controller to the USB
module

SetControlOutCont
ents

Overwrite data sent from the host

BE2ByteRead Convert 2-byte data to big endian

LE2ByteRead Convert 2-byte data to little endian

ActBusReset Clear buffer, flag, and FIFO on receiving bus reset

SetUsbModule Initial setting of USB module

UsbMain.c

USBclear Clear ring buffer and flag

In UsbMain.c, interrupt sources are determined by the USB interrupt flag register, and functions
are called according to the interrupt type. Also, packets are sent and received between the host
controller and function modules.
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Table 3.2-2   StartUp.c

File in Which
Stored

Function Name Purpose

CallResetException Operates for reset exception and calls function to be
executed

CallGeneralExcepti
on

Calls function corresponding to general exception except
for TLB miss occurrence

CallTLBMissExcept
ion

Calls function corresponding to TLB miss occurrence

CallInterrupt Calls function corresponding to interrupt request

SetPowerOnSectio
n

Module and memory initialization, and shift to main loop

_INITSCT Copies variables that have initial settings to the RAM
work area

InitMemory Clears RAM area used in bulk communicatuion

InitSystem Pull-up control of the USB bus

Error Shifts CPU to sleep mode when error occurs

Scilnit SCIF2 initialization

StartUp.c

Set_SMR Initial setting of SCSMR2 of SCIF2

When a power-on reset or manual reset is carried out, CallResetException is called.  At this point,
the SH7727 initial settings are carried out. After that, the RAM area used for the control transfer
and bulk transfer is cleared using SetPowerOnSection.

Table 3.2-3   DoSerial.c

File in Which
Stored

Function Name Purpose

ActSerialOut Data is read from the read pointer and passed to
ExSerialOut by 1 byte as parameter

ActSerialIn Write serially-input data to the area for bulk-in transfers

WriteBulkInArea Write data to the area for bulk-in transfers

DoSerial.c

ExSerialOut 1-byte data is serially output from SCIF2

In DoSerial.c, serial transmission and reception are executed as well as SCIF2 module control.
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Table 3.2-4   DoRequest.c

File in Which
Stored

Function Name Purpose

DoRequest.c
DecStandardComm
ands

Decode command issued by host controller, and process
those which are standard commands

During control transfer, commands sent from the host controller are decoded, and commands are
processed.  In this sample program, a vendor ID of 045B (vendor: Hitachi) is used.  When the
customer develops a product, the customer should obtain a vendor ID at the USB Implementers’
Forum.

Table 3.2-5   DoControl.c

File in Which
Stored

Function Name Purpose

ActControl Carries out the setup stage of control transfer

ActControlIn
Carries out the data stage and status stage of control IN
transfer (transfer in which the data stage is in the IN
direction)DoControl.c

ActControlOut
Carries out the data stage and status stage of control
OUT transfer (transfer in which the data stage is in the
OUT direction)

When the control transfer interrupt (EP0oTS) is generated, ActControl obtains the command, and
decoding is carried out by DecStandardCommands.  Next, the data stage and status stage are
carried out using either ActControlIn or ActControlOut, depending on the type of command.

Table 3.2-6   DoBulk.c

File in Which
Stored

Function Name Purpose

ActBulkOut Controls bulk-out-transfer

ActBulkIn Controls bulk-in transfer

ExBulkOut Execute GetPacket
DoBulk.c

ExBulkIn Execute PutPacket

These functions carry out processing involving bulk transfer as well as sending and receiving the
data, and controlling the flow.
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Table 3.2-7   DoRequestVenderCommand.c

File in Which
Stored

Function Name Purpose

DoRequestVen
derCommand.c

DecVenderComma
nds

Responds to vendor commands

These functions carry out processing according to the vendor commands.  In this sample program,
processing is executed for the four vendor commands supported by the USB serial conversion
driver manufactured by Hitachi ULSI Systems Co., Ltd.  For details, refer to section 4.7, Vendor
Command.

Figure 3.3 shows the interrelations between the functions explained in table 3.2.  The upper-side
functions call the lower-side functions.  Also, multiple functions may call the same function.  In
the stationary state, SetPowerOnSection calls other functions, and in the case of a transition to the
USB communication state which occurs on an interrupt, CallInterrupt which is an interrupt
function calls BranchOfInt and BranchOfInt calls other functions.  In the SCIF2 interrupt,
CallInterrupt calls ActSerialIn.  Figure 3.3 shows the hierarchical relation of functions; there is no
order for function calling.  For information on the order in which functions are called, refer to the
flowcharts in section 4, Sample Program Operation.
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SetPowerOnSection

CallResetException

BranchOfInt

CallInterrupt

InitSystemActBulkIn

ExBulkIn

PutPacket

InitMemory INITSCT

ActControlOut ActControlIn

PutPacket

ActControl ActBulkOut

ExBulkOutDecStandardCommands

DecVenderCommands GetPacket

ActSerialOut

ExSerialOut

LE2ByteRead

ActSerialIn

USBFI0 interrupt input ERI2, RXI2, or BRI2 interrput input

Figure 3.3   Interrelationship between Functions
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Section 4   Sample Program Operation

In this section, the operation of the sample program is explained, relating it to the operation of the
USB function module.

4.1 Main Loop

When the microcomputer is in the reset state, the internal state of the CPU and the registers of
internal peripheral modules are initialized. Next, the function SetPowerOnSection in StartUp.c is
called, and the CPU is initialized. Figure 4.1 is a flow chart for the SetPowerOnSection.
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Start

After initialization, this program is entered in the main
loop. In the main loop, whether or not data to be 
output is in the RAM area is monitored constantly. 
If any data is detected, the data is output to the PC 
by bulk-in or serial-out transfer.

An SCIF2 interrupt notifies the data reception and the
data received with the SCIF2 module is stored in the
RAM area for bulk-in transfer. 
If any data detected in this area, it is transferred to 
the USB-host PC using bulk-in pipe.

An USB interrupt notifies the data reception and the 
data received using bulk-out transfer for the USB 
module is stored in the RAM area for bulk-out 
transfer.
If any data is detected in this area, it is transmitted 
to the PC connected with serial interface.

NO

YES

Initialize microcomputer

RAM cleared

Initialize variables

Initialize SCIF2

Data 
detected in RAM area 

for bulk-in transfer

Output to USB host PC
(bulk-in transfer)

StartUp.c <SetPowerOnSection>

Data 
detected in RAM area 
for bulk-out transfer?

Output to PC connected 
with serial interface 
(serial transmission)

NO

YES

NO

Figure 4.1   Main Loop

4.2 Types of Interrupts

As explained in section 3.1, the interrupts used in this sample program are indicated by the USB
interrupt flag register 0 (USBIFR0), USB interrupt flag register 1(USBIFR1) and serial status
register (SCSSR2); there are three types of USB interrupts and three type of serial interrupts.
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When a USB interrupt occurs, the corresponding bit in the interrupt flag register is set to 1 and a
USBFI0 interrupt request is sent to the CPU. In the sample program, when the interrupt occurs, the
CPU reads the interrupt flag register to perform the corresponding USB communication. Figure
4.2 shows correspondence between the interrupt flag registers and USB communications.

Bulk-in transfer is supported in this sample program. It, however, is enabled not by an interrupt
operation, but by branching from the main routine. Therefore, bulk-in interrupt should be disabled
and monitoring the EP2 EMPTY flag activates bulk-in transfer. The EP2TR bit is not be used.

BRST

Bit:

Bit name:

Bit:

Bit name:

Because this sample program does not support interrupt transfers, 
interrupts relevant to EP3 are not used.

EP1
FULL

EP2
TR

EP2
EMPTY

SETUP
TS

EP0o
TS

EP0i
TR

EP0i
TS

7 6 5 4 3 2 1 0

Bulk-out transferCable connection
(bus reset)

Control transfer

USB interrupt flag register 0 (USBIFR0)

USB interrupt flag register 1 (USBIFR1)

EP3
TR

EP3
TS

VBUS

7 6 5 4 3 2 1 0

Not used* Not used

Not used Bulk-in transfer

Note:  

VBUS
MN

Not used

Figure 4.2   Types of USB Interrupt Flags

When an SCIF2 interrupt occurs, the corresponding bit in the serial status register is set to 1 and
an interrupt request is sent to the CPU. In this sample program, the transmit FIFO data empty and
receive FIFO data full, that is, serial transmission and serial reception functions are supported.
However, since the serial transmission is executed not by an interrupt operation, but by branching
from the main loop, it is used only as a flag and the interrupt function is not used.
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PER3

Bit:

Bit name:

Bit:

Bit name:

PER2 PER1 PER0

7 6 5 4 3 2 1 0

Receive FIFO data empty
(serial transmission)

Receive error
(serial reception)

Serial status register (SCSSR2)

PER RDF DR

7 6 5 4 3 2 1 0

ER TEND TDFE BRK

Break detect
(serial reception)

Receive data FIFO full
(serial reception)

FER

Note:  The SCIF2 which carries out serial transmission and reception has 16-stage FIFO.
However, in this sample program, only 1-stage FIFO is used.  
The receive FIFO data number trigger and transmit FIFO data number trigger are specified 
to 14 and 0, respectively.  If the transfer needs to be performed more efficiently, the settings 
of SCFCR2 should be adjusted.

FER3 FER2 FER1 FER0

Figure 4.3   Types of Serial Interrupt Flags

4.2.1 Branching to Transfer Function

In this sample program, the transfer type is determined by method of calling each transfer
function. The calling methods are a branch from the main loop and an interrupt from the USB
function or SCIF2 module. Table 4.1 shows correspondence between transfer types and methods
of calling each transfer function.

When branching from the main loop, the function is directly called. This method corresponds to
serial-out transfer (ActSerialOut) and bulk-in transfer (ActBulkIn). When branching by a USB
interrupt, the branch is carried out by the BranchOfInt in UsbMain.c. This method corresponds to
cable connection (ActBusReset), control transfer (ActControl) and bulk-out transfer
(ActBulkOut). When branching by an SCIF2 interrupt, the function is directly called because
transfer functions are determined by interrupt sources in the SCIF2 module, such as ERI2, RXI2,
BRI2 and TXI2. This method corresponds to serial-in transfer (ActSerialIn).
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Table 4.1 Transfer Type and Method of Calling Function

Module Transfer type Method of calling

USB Cable connection (bus reset) USB interrupt

Control transfer USB interrupt

Bulk-out transfer USB interrupt

Bulk-in transfer Branch from main loop

SCIF2 Serial-in transfer SCIF2 interrupt

Serial-out transfer Branch from main loop

Table 4.2 shows the correspondence between the USB interrupt types and the function called by
BranchOfInt.

Table 4.2 USB Interrupt Types and Called Functions

Register Name Bit Bit Name Name of Function Called

USBIFR0 0 EP0i TS ActControlIn, ActControlOut

1 EP0i TR ActControlOut

2 EP0o TS ActControlOut

3 SETUP TS ActControl

4 EP2 EMPTY   (branch from main loop)

5 EP2 TR 

6 EP1 FULL ActBulkOut

7 BRST ActBusReset

The EP0i TS and EP0o Ts interrupts are used both for control-in and control-out transfers. Hence
in order to manage the direction and stage of control transfer, the sample program has three states:
TRANS_IN, TRANS_OUT, and WAIT. For more details, refer to section 4.4, Control Transfers.
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Table 4.3 shows SCIF2 interrupt types and called functions.

•  Serial Status Register (SCSSR2)

Table 4.3 SCIF2 Interrupt Types and Called Functions

Register Name Bit Bit Name Name of Function Called

SCSSR2 15 to 8  

7 ER ActSerialOut

6  

5 TDFE ActSerialOut

4 BRK ActSerialOut

3 and 2  

1 RDF   (branch from main loop)

0  

From the next section, details of application-side firmware are explained for each USB and SCIF2
transfer type.
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4.3 Interrupt by Cable Connection (BRST)

This interrupt occurs when a USB cable is connected to the host controller. After completion of
initializing the microcomputer, the application side pulls up the USB data bus D+ using general-
purpose output port. By means of this pull-up, the host controller detects that the device has been
connected (figure 4.4).

SetPowerOnSection

Microcomputer
initial settings

Main loop

0 write to the pull-up
enable bit in the USBDMA
setting register and
the USB1_pwr_en pin
is driven low

USB function module

Cable disconnected
VBUS=0

UDC core reset

USB cable connected Cable connected

USB1_pwr_en pin
D+ pull-up enabled?

UDC core reset
canceled

Bus reset signal received
USBIFR0/BRST=1
Bus reset interrupt

Waiting for setup command
receive complete interrupt

Sample program

NO

YES

USBFI0 interrupt
generated

The output level of the
USB1_pwr_en pin set to high

with the USBDMA setting register

The port D6 function specified
as USB clock input pin

The port E2 function specified
as USB1_pwr_en pin

The USB interrupt priority
selected by interrupt

priority register G

48-MHz clock selected
for the USB clock by

EXCPG control register

USB transceiver 1 enabled by
extra pin function controller

register

Necessary interrupt requests
enabled by USB interrupt

enable registers

The vector numbers for interrupt
requests selected by the USB

interrupt select registers

ActBusReset

All FIFOs cleared

Buffer and flags 
in firmware cleared

Bus reset flag cleared
(USBIFR1/BRST)

USBF clock stopped 
by standby control register 3

USBF clock restarted 
by standby control register 3

Figure 4.4   Interrupt by Cable Connection
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4.4 Control Transfers

Control transfers are performed using bits 0 to 3 of the interrupt flag registers. Control transfers
are divided into two types according to the direction of data in the data stage (see figure 4.5). In
the data stage, data transfer from the host controller to the USB function module is control-out
transfer and transfer in the opposite direction is control-in transfers.

Control-out transfer

Control-in transfer

Host controller USB function module

Data (Data stage)

(Data stage)Data

Host controller USB function module

Figure 4.5   Control Transfers

Control transfers consist of three stages: setup, data (no data is possible), and status (see figure
4.6). Furthermore, a data stage consists of multiple bus transactions.

In control transfers, stage changes are detected by inverting the data direction. Hence the same
interrupt flag for either control-in or control out transfer is used to call a function (see table 4.1).
For this reason, the firmware must manage the control transfer type currently being performed,
control-in or control-out transfer, in each state (see figure 4.6) and must call the appropriate
function. States in the data stage (TRANS_IN, TRANS_OUT) are determined by commands
received in the setup stage.
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DATA0

SETUP (0)Control-in

Firmware state

Control-out

Firmware state

No data

Firmware state

IN (1) OUT (1)IN (0)

SETUP (0)

SETUP (0)

OUT (1) OUT (0)

IN (0/1)

IN (1)

IN (1)

OUT (0/1)

...

...

Setup stage Data stage Status stage

DATA1 DATA0 DATA0/1 DATA1

WAITWAIT TRANS_IN

DATA0 DATA1 DATA0 DATA0/1 DATA1

WAITWAIT TRANS_OUT

DATA0 DATA1

WAITWAIT TRANS_OUT

Figure 4.6   Stages in Control Transfers

4.4.1 Setup Stage

In the setup stage, commands are transferred between the host controller and USB function
module. The firmware is entered in the WAIT state on both control-in and control-out transfers.
Whether control-in transfer or control-out transfer is performed is determined by the type of the
issued command and the state of the firmware in the data stage (TRANS_IN or TRANS_OUT) is
also determined.

•  Commands for control-in transfer: GetDescriptor (TRANS_IN) standard command
GetLineCoding (TRANS_IN) vendor command

•  Commands for control-out transfer: SetLineCoding (TRANS_OUT) vendor command
SetControlLineState (TRANS_OUT) vendor command
SendBreak (TRANS_OUT) vendor command

Figure 4.7 shows operation of the sample program in the setup stage. The figure on the left shows
operation of the USB function module.
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Figure 4.7   Setup Stage
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4.4.2 Data Stage

In the data stage, data is transferred between the host controller and USB function module. The
firmware is entered in TRANS_IN state for control-in transfer or in TRANS_OUT state for
control-out transfer according to the result of decoding the command in the setup stage. Figures
4.8 and 4.9 show the operation of the sample program in the data stage on control transfers.
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When firmware is in TRANS_IN state
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data stage is terminated and
status stage is entered.
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USBIFR0/EP0i TS 
interrupt flag cleared
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EP0i packet enable bit set to 1
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Figure 4.8   Data Stage (Control-In Transfer)
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Figure 4.9   Data Stage (Control-Out Transfer)
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4.4.3 Status Stage

The status stage is started by a token with the opposite direction of the data stage, that is, the status
stage is started by an out-token from the host controller on control-in transfer and is started by an
in-token from the host controller on control-out transfer.
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Control transfer end

EP0o receive complete flag set
(USBIFR0/EP0o TS = 1)
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NO

ACK

USBFI0 interrupt generated

Receive complete interrupt?
(USBIFR0/EP0o TS)

EP0o-related interrupt
flags excluding SETUP

flag cleared

Firmware state
changed to WAIT

EP0o receive complete flag set to 1
(USBTRG/EP0o RDFN = 1)

Control-in transfer end

To data stage

Figure 4.10   Status Stage (Control-In Transfer)
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Figure 4.11   Status Stage (Control-Out Transfer)
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4.5 Bulk Transfers

Bulk transfers are performed using bits 4 to 6 of the interrupt flag registers (bits 4 and 5 are not
used because a bulk-in transfer is not enabled by an interrupt in this program). Bulk transfers are
also be divided into two types according to the direction of data transfer (figure 4.12).

Data transfer from the host controller to the USB function module is bulk-out transfer and data
transfer in the opposite direction is bulk-in transfer.

USB function moduleHost controller

Bulk-out transfers

Bulk-in transfers

Data

Data

USB function moduleHost controller

Figure 4.12   Bulk Transfers

4.5.1 Bulk-Out Transfers

Figure 4.13 shows the operations of the sample program when bulk-out transfer is carried out.
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Any space 
in both EP1 FIFOs?

USB function module Sample program

YES

YES

ActControlOut

ExBulkOut

Data read from USBEP1 
data register (USBEPDR1)

 is stored in RAM area 
for bulk-out transfer

EP1 read complete bit set to 1
(USBTRG/EP1 RDFN = 1)

NO

NO

ACK

NAK
Any space 

in RAM area for bulk-out
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EP1 FULL interrupt disabled
(USBIFR1/EP1FULL = 0)

EXIRQ0 interrupt occurred

NO

Figure 4.13   Bulk-Out Transfers

4.5.2 Bulk-in Transfers

Figure 4.14 shows the operation of the sample program when bulk-in transfer is carried out.
Unlike bulk-out transfer, bulk-in transfer is not started by an interrupt and is started by a branch
from the main loop.

When there is no space in the RAM area and the serial-in transfer is disabled, data stored in the
RAM area for bulk-in transfer can be written to the USBEP2 data register. Whether or not the
RAM area is made available by this write operation can be checked. When the RAM area is made
available, serial-in transfer can be enabled.
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Figure 4.14   Bulk-In Transfer

4.6 Serial Transfer

The SCIF2 module is used for serial transfer. Serial-out transfer is performed by branching from
the main loop and serial-in transfer is performed by an interrupt. The RDF flag of the serial status
register (SCSSR2) is used on serial-in transfer.

4.6.1 Serial-Out Transfer

Figure 4.15 shows the operation of the sample program on serial-out transfer. When any data is in
the RAM area for bulk-out transfer, the ActSerialOut function is called to branch from the main
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loop and the SCIF2 module is used to transfer the data. When data is not in the RAM area for
bulk-out transfer and the bulk-out transfer is disabled, whether or not the RAM area is made
available by this serial-out transfer can be checked. When the RAM area is made available, bulk-
out transfer can be enabled.

NO

NO

YES

NO

YES

NO

YES

YES

Main loop

ActSerialOut

ExSerialOut

EP1 FULL interrupt enabled
(USBIER0/EP1FULL = 1)

Data for serial-out
transfer?

Transmssion Data write 
to SCFTDR2

SCSSR2 TDFE = 1?

SCSSR2 TDFE/TEND
cleared

Bulk-out disabled?

Any space 
in RAM area for bulk-out

transfer?

Calculate byte size 
of transfer data

Figure 4.15   Serial-Out Transfer
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4.6.2 Serial-In Transfer

Figure 4.16 shows the operation of the sample program on serial-in transfer. When ERI2, BRI2, or
RXI2 interrupt for serial reception occurs, the ActSerialIn function is called. When ERI2 or BRI2
interrupt occurs, the sample program exits the function after reading and discarding a received
data. When RXI2 interrupt occurs, the sample program reads a received data via the SCIF and
stores the data in the RAM area for bulk-in transfer. After that, the sample program checks the
available size of the RAM area for bulk-in transfer. When there is no available area, an Xoff is
output to the PC connected with serial interface to avoid data underrun and disable the serial-in
transfer.

Serial-in transfer end

ActSerialIn

Dummy read

NO

Received data read 
from SCFRDR2

YES

NO

Break input?

YES

SCSSR2 RDF cleared

Received data stored in
RAM area for bulk-in transfer

Serial-in disabled (Xoff 
transferred by serial-out transfer)

NO

Any space 
in RAM area for bulk-in

transfer?

YES

ERI2, BRI2, or RXI2 interrupt occurred

Dummy readReceive error interrupt?

Figure 4.16   Serial-In Transfer
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4.7 Vendor Command

In this sample program, four vendor commands, supported by USB serial conversion driver
manufactured by Hitachi ULSI Systems Co., Ltd., are decoded.

Table 4.4 shows the four vendor commands that are supported by the USB serial conversion
driver.

Table 4.4(a) Vendor Request

bmRequestType bRequest wValue wIndex wLength Data

01000001b SET_LINE_CODING Zero Interface 8 Line Coding
Structure

11000001b GET_LINE_CODING Zero Interface 8 Line Coding
Structure

01000001b SET_CONTROL_LINE
_STATE

Control Signal
Bitmap

Interface Zero None

01000001b SEND_BREAK Duration of Break Interface Zero None

Table 4.4(b) Vendor Request Code

bRequest Value

SET_LINE_CODING 0

GET_LINE_CODING 1

SET_CONTROL_LINE_STATE 2

SEND_BREAK 3

More details of each command are explained in the following sections.

4.7.1 SetLineCoding

This request specifies parameters which are used for asynchronous data transfer.

bmRequestType bRequest wValue wIndex wLength Data

01000001b SET_LINE_CODING Zero Interface 8 Line Coding Structure

Table 4.5 shows the definition of Line Coding Structure.

In this sample program, SCIF2 is restarted with the settings of received Line Coding Structure on
reception of this command.
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Table 4.5 Line Coding Structure

Offset Field Size Value Description

0 DwDTERate 4 Number Data terminal speed (bps)

4 BcharFormat 1 Number Stop bit

0: 1 stop bit

1: 1.5 stop bits

2: 2 stop bits

5 BparityType 1 Number Parity

0: None

1: Odd

2: Even

3: Mask

4: Space

6 BdataBits 1 Number Data bits (5, 6, 7, 8)

7 BflowType 1 Number Flow control

0: Software or none

1: Hardware

4.7.2 GetLineCoding

This request is for the host to check out the current parameter of the device. When this sample
program receives this command, it returns the initial values shown in table 4.6 to the host.

bmRequest
Type

bRequest wValue wIndex wLength Data

11000001b GET_LINE_
CODING

Zero Interface 8 Line Coding
Structure

Table 4.6 Initial Values of Line Coding Structure

Offset Field Size Value Description

0 DwDTERate 4 0x1C200 Data terminal speed (115200bps)

4 BcharFormat 1 0x0 Stop bit (1 stop bit)

5 BparityType 1 0x0 Parity (None)

6 BdataBits 1 0x8 Data bits (8)

7 BflowType 1 0x0 Flow control (Software or none)
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4.7.3 SetControlLineState

This request sets the control signal.

bmRequestType bRrequest wValue wIndex wLength Data

01000001b SET_CONTROL_
LINE_STATE

Control Signal
Bitmap

Interface Zero None

Table 4.7 Control Signal Bitmap

Bit Position Description

D15 to D2 Reserved (initialized to 0)

D1 Controls transmit function of DCE

0: RTS off

1: RTS on

D0 Monitors whether or not DTE is in ready state

0: DTR off

1: DTR on

Since the SH7727 does not have RTS and DTR signals, only decode is carried out for this request
and the DCE is not controlled.

In this sample program, it is recognized that setting the hyper terminal on the USB host PC side
for communication is completed by detecting D1 = 1 and D0 = 1. At this time, a pointer that
indicates the data area for bulk-in and bulk-out transfers and an internal flag in this sample
program are initialized.

4.7.4 SendBreak

This request generates the break signal in device.

bmRequestType bRequest wValue wIndex wLength Data

01000001b SEND_BREAK Duration of Break Interface Zero None

The break signal transmission time (msec) is written to the wValue field. When wValue is
0xFFFF, the device continues to output the break signal until receiving the SendBreak request
with wValue of 0x0000.

In this sample program, this request is decoded. A break signal, however, is not output.
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Section 5   Analyzer Data

In this section, we look at how measurement is carried out with the USB Advisor, a USB protocol
analyzer manufactured by CATC (http://www.catc.com), using the USB function module in the
SH7727, and at what happens to the data as it actually flows along the bus. The following gives
the description for control transfer when a device is connected and control transfer when the
vendor command is transmitted as examples.

Note: The Packet # found in front of each packet is the packet number used when measuring.

The Idle found at the end of each packet indicates the idle between packets.

5.1 Control Transfer when Device is Connected

Figure 5.1 shows the measurement made, with a device connected to the host controller, while
shifting from the power-on state (the power is supplied to Vbus) until the configuration state
(device is ready for being used).

Though the packet scheduling may differ depending on the host controller, the command flow to
the configuration state is always the same.
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Reset signal is input again
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Figure 5.1   Control Transfer when Device is Connected
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5.2 Control Transfer when Vendor Command is Transmitted

Figure 5.2 shows the measurement results when the vendor command is transmitted by control
transfer between the host controller and this device (For vendor command, refer to section 4.7).
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